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Course Description 
 
Study and creation of maps. Fundamental mapping principles (projection, scale, generalization, 
symbolization) and computer-based cartographic production. Fee 



Mathematics [CS] 
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Proposer:  Please complete the following section and attach appropriate documentation. 
 

ASU--[CS] CRITERIA 
A COMPUTER/STATISTICS/QUANTITATIVE APPLICATIONS [CS] COURSE  

MUST SATISFY ONE OF THE FOLLOWING CRITERIA:  1, 2, OR 3 

YES NO  
Identify 
Documentation 
Submitted 

1.  Computer applications*:  courses must satisfy both a and b:  

  
      a.  Course involves the use of computer programming 
           languages or software programs for quantitative analysis,  
           modeling, simulation, animation, or statistics.  

The syllabus and the 
course schedule have 
been annotated in 
yellow to indicate 
where this criteria has 
been met  

 
      b.  Course requires students to analyze and implement  
           procedures that are applicable to at least one of the  
           following problem domains (check those applicable): 

      

  i. Spreadsheet analysis, systems analysis and design,   
and decision support systems.  

      

  ii. Graphic/artistic design using computers. 
Lab 2 is attached.  Lab 
2 exemplifies how this 
criteria is met. 

  iii. Music design using computer software. 
      

  iv. Modeling, making extensive use of computer  
 simulation.  

Lab 3 is attached.  Lab 
2 exemplifies how this 
criteria is met. 

  v. Statistics studies stressing the use of computer  
 software. 

      

*The computer applications requirement cannot be satisfied by a course, the content of which is 
restricted primarily to word processing or report preparation skills; learning a computer language or a 
computer software package; or the study of the social impact of computers.  Courses that emphasize 
the use of a computer software package or the learning of a computer programming language are 
acceptable, provided that students are required to understand, at an appropriate level, the theoretical 
principles embodied in the operation of the software and are required to construct, test, and 
implement procedures that use the software to accomplish tasks in the applicable problem 
domains. 

 2.  Statistical applications: courses must satisfy both a and b.  

  
a. Course has a minimum mathematical prerequisite of 
 College Mathematics, College Algebra, or Precalculus, or 
 a course already approved as satisfying the MA 
 requirement. 
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Course Prefix Number Title Designation 

GPH 371 Introduction to Cartography and 
Geographic Visualization CS 

 
Organizer to explain how the course meets CS Criteria. 

 
Criteria (from 
checksheet) 

How course meets spirit 
(contextualize specific 

examples in next column) 

Please provide detailed evidence of how 
course meets criteria (i.e., where in 

syllabus) 

1a.  
Course involves the use of 
computer programming  
languages or software 
programs for quantitative 
analysis,  
modeling, simulation, 
animation, or statistics.  

Students in cartography use 
several different software 
programs that involve first 
quantitative analysis to analyze 
statistics. Then, the maps 
themselves represent a discrete 
type of spatial modeling that 
generalizes the analyzed data.  
Cartography is the art and science 
of communicating geographic 
information through maps.  Maps 
frequently are tools for 
visualizing quantitative data that 
can’t be directly viewed:  
demographic characteristics, earth 
structures, climate patterns, etc.  
In this second role, maps act as 
models that help us understand 
geographic phenomena. 

In syllabus, course objective states: 
 
Cartography is a fundamental tool of 
geography; it is also a science and art in 
its own right.  Cartography uses principles 
of design, perception, statistics, and 
communication.  A skilled cartographer 
draws on knowledge from all these areas, 
plus the critical element of his or her own 
creativity, to create maps that are 
compelling and accurate.  By the end of 
the semester, you should be able to use 
principles, skills, and creativity to 
transform numerical or verbal data into 
effective, powerful maps.  You will also 
learn how to use two software products, 
ESRI ArcGIS and Adobe Illustrator, as 
tools for effective cartographic 
representation.   
 

1b ii.   
Course requires students 
to analyze and implement  
procedures that are 
applicable to …  
Graphic/artistic design 
using computers.  

Cartography draws from the field 
of graphic design as well as 
perceptual studies in psychology.  
Lectures introduce principles 
from both these fields as well as 
others developed through research 
by cartographers.   
Each major conceptual topic is 
accompanied by a lab in which 
students are asked to create a map 
applying the principles just 
introduced, using computer 
software to carry out the project.  
This hands-on approach allows 
students to develop problem-
solving skills simultaneously in 
both the software tools and the 
subject domain of cartography. 

Labs 2, 3, 4, 6 and 7.  For example, the 
lab 2 introduction reads: 
 
The primary objective of this project is for 
you to design a simple map from beginning 
to end; being conscious of your map’s 
purpose and the design strategies you use 
to achieve that purpose.  In addition, you’ll 
practice the Illustrator techniques you 
learned in lab 1 – creating and modifying 
objects and text, organizing a file through 
the use of layers, etc.  

 
-- Continued on next page --
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1b iv.  
Course requires students 
to analyze and implement  
procedures that are 
applicable to … 
iv. Modeling, making 
extensive use of computer  
simulation.  

As described under 1a, 
cartography is a tool for modeling 
geographic phenomena; using 
maps as a tool for visualizing 
geographic data. 
 

The following labs emphasize modeling: 
 
Lab 3: Projections – students learn to 
select an appropriate map projection, based 
on map purpose and area of the globe 
represented.  students need to consider 
error associated with projecting the curved 
surface of the earth on a flat map. 
 
Lab 5: Spatial data – gives students 
practice in distinguishing data in terms of 
levels of measurement and spatial 
distribution represented. 
 
Lab 6: Proportional symbols – students 
deal with a problem of representing 
quantitative data using proportional 
symbols. 
 
Lab 7: Choropleth maps – students deal 
with issues of grouping quantitative data 
into classes, and representation of the 
classes on maps. 
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R$6$&)7'A)/'+6!M$2%$.')77*!2$7$./'+6!?!C#)/!5$+5&)%#'.!$7$($6/2!)64!23%%+&/'65!
'61+&()/'+6!/+!'6.734$N!
"#$!()%92!0'23)7!)64!'61+&()/'+6!#'$&)&.#*!
L'53&$P5&+364!4$0$7+%($6/!
D*(,+7!4$2'56!)64!0'23)7!.+6/&)2/!
S$5','7'/*!
T'23)7!,)7)6.$!)64!7)*+3/!

!
OD).%.B%."@>%<>$%
!

>: !!G!:E)AHG)>(GCD<.#%-@<>.%BF%*B"@%4)-!
U: !B+3&!4)-%-E)><!/*%$4!M/$(%7)/$!'2!)0)'7),7$!+6!.7)22!C$,2'/$N!
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!"#$%&'"%(!
!

"# )%*+,-.#-/01,-1,&-&%2+*,-3#'"-41/(-

$# %&'()&!*+!,-&!./0.*1&!*2!3*/0!4$.!5.$0,3!(+6(,$,(*+7!&,'#8!$+)!,-&!*0(9(+!$+)!)&1,(+$,(*+!
,-$,!(,!:(;;!1-*:#!

<# =*4&!/.!:(,-!$!,&+,$,(6&!;$3*/,!2*0!3*/0!4$.!>!?!1/99&1,!)*(+9!,-(1!(+(,($;;3!:(,-!.&+'(;!
$+)!.$.&0#!

'# @1!3*/!:*0A!*+!,-&!;$3*/,7!,-(+A!$<*/,!:-$,!9&*90$.-('!2&$,/0&1!$+)!1/..*0,(+9!
&;&4&+,1!5;&9&+)7!&B.;$+$,*03!,&B,7!&,'#8!1-*/;)!<&!(+';/)&)#!!@;1*!'*+1()&0!,-&!4$.C1!
D(+2*04$,(*+!-(&0$0'-3E!FF!:-$,!&;&4&+,1!$0&!4*1,!(4.*0,$+,G!!H-$,!&;&4&+,1!9(6&!
1/..*0,(+9!(+2*04$,(*+!</,!$0&!;&11!'0(,('$;G!

)# I$1&)!*+!,-&!.;$++(+9!3*/C6&!)*+&7!4$A&!1*4&!+*,&1!*+!,-&!4$.C1!'*+'&.,!$+)!)&1(9+7!
/1(+9!,-&!D4$.!.;$+E!:*0A1-&&,!$ $'-&)#!!5@!)(9(,$;!6&01(*+!(1!$6$(;$<;&!*+!,-&!';$11!
:&<!1(,&7!/+)&0!DJ$<!?+2*E#!!K*/0! ;!4$.!.;$+!1-*/;)!<&!,3.&)7!/1(+9!,-(1!,&4.;$,&#8!

L# 5#,2."'$.-.6%-41/-+,-700'2."1.#"8-!?!1/99&1,!,-&!2*;;*:(+9!1,&.1M!

&# ?+!$!+&:7!<;$+A! 7!'0&$,&!$,!;&$1,!,:*!;$3&01!>!*+&!2*0!,&B,7!$+)!*+&!2*0!9&*90$.-('!
&;&4&+,1#!!K*/!4$3!)&'()&!,*!'0&$,&!1&.$0$,&!;$3&01!2*0!0*$)17!A&3!;*'$,(*+17!&,'#!!N*4&!
.&*.;&!.0&2&0!4*0&!;$3&017!1*4&!.0&2&0!2&:&0O!

2# N&,!/.!9/()&1!,*!-&;.!3*/!6(1/$;(P&!,-&!4$B(4/4!$0&$!*2!3*/0!4$.!!"#$$!%$&'!()*$!+,-!
.$')/0#1#!

9# I&9(+!,*!)0$:!,-&!9&*90$.-('!2&$,/0&1!3*/C6&!)&'()&)!,*!(+';/)&7!/1(+9!,-&!Q&+!,**;!$+)!
9&*4&,0('!1-$.&!,**;17!$1!3*/C6&!;&$0+&)!,*!)*!(+!,-&!.0&6(*/1!&B&0'(1&1#!!R&4&4<&0!
1*4&!<$1('!134<*;!'-$0$',&0(1,('1!3*/!'$+!'*+,0*;!S!

J(+&!:(),-!
J(+&!$+)! ;!'*;*0!"#$$!%$&'!#$2'/,%!+,-!#3**$#'/,%#!,%!2-$)'/%*!*-$4!#5).$#1!

-# @))!,&B,7!0&4&4<&0(+9!,-$,!3*/!'$+!'*+,0*;!##!
T3.&!1(P&!
U*+,!
N,3;&!50&9/;$07!<*;)!*0!(,$;('8!
R*,$,(*+!*2!,&B,!"6$&'!#$2'/,%!*/7$#!/%#'-32'/,%#!,%!8)%/(30)'/%*!'5$#$!+$)'3-$#1!

!
U&&;!20&&!,*!&B.;*0&!*,-&0!2&$,/0&1!*2!?;;/1,0$,*07!(2!3*/!;(A&7!$1!1,0$,&9(&1!,*!1,0&+9,-&+!3*/0!
4$.C1!)&1(9+#!

!
V# 9:10'1.%-3#'"-41/8!!R&F0&$)!3*/0!4$.!.;$+!+*,&17!$+)!,$A&!$!20&1-!;**A!$,!,-&!4$.W!,-&+!0&6(1&!

&(,-&0!,-&!4$.!*0!,-&!X$.!Q;$+7!(2!3*/!,-(+A!&(,-&0!'$+!<&!(4.0*6&)#!
!

Y# ;'",-+,-3#'"- -41/-1,&-1- 0 -<=1/-!01,8>!! !!"9,%:' !'3-%!/%!'5/# !/%#'-32'/,% !#5$$';1 !

!
?"1&+,*-
!

U*0!,-(1!$11(9+4&+,7!$+)!$;;!*,-&0!$11(9+4&+,1!,-$,!(+6*;6&!)&1(9+(+9!$!4$.7!90$)(+9!:(;;!<&!<$1&)!*+!
$+!&6$;/$,(*+!'-&'A;(1,#!!T-&!'-&'A;(1,1!$0&!.*1,&)!*+!,-&!';$11!:&<1(,&7!(+!,-&!;$<!2*;)&0!/+)&0!D@1A-7,B##E

T/0+!(+!&(,-&0!$!/"+,.!*2!,-&!4$.!*0!$! File > Save As7!
$+)!/+)&0!DSave as type:E!'-**1&!Adobe PDF.
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!"#$%&''()("*&+%)$,-*(./$0%1"2%)-(0%#&3%
!
45% %/3% %)"%0-"6%#&3%0(7$%+(#()0%
!

"# $%!&%!'File > Document Setup()!*+,!-./-0!&.*&!1%23!,%-24/+&!5677!8.%5!
4/*823/4/+&8!6+!6+-./8!!"#$#%&'($")$*+,%)-#!!9:!6&;8!8/&!&%!8%4/!%&./3!2+6&8)!-.*+</!
&./!8/7/-&6%+!&%!'8*,-$0(#!!

=# 92&6%&% $%6()-%'(#$*0("*0%"1%:;%<%=;>!!!>/7/-&!&./!3/-&*+<7/?,3*56+<!&%%7!

@ !A!&.*&!1%2!28/,!6+!B3/C6%28!7*D8#!!E2&!&.68!&64/)!6+8&/*,!%:!,3*<<6+<!&./!
8.*B/!%:!*!3/-&*+<7/!%+!&./!-*+C*8)!-76-0!%+-/!*+15./3/!%+!&./!-*+C*8#!!F!,6*7%<!
D%G!5677!*BB/*3)!6+!5.6-.!1%2!-*+!/+&/3!*!56,&.!%:!H(!*+,!./6<.&!%:!I(!@"2%)-$%2$?$20$)!,/B/+,6+<! ! ! !
%+!&./!8.*B/!%:!&./!4*B!7*1%2&!1%2;C/!B7*++/,A#!!J76-0!'KL(!*+,!&./!3/-&*+<7/!5677!*BB/*3!%+!
1%23!B*</#!

M# N3*<!&./!3/-&*+<7/!&%!&./!*BB3%G64*&/!-/+&/3!%:!&./!,%-24/+&!B*</#!

O# @"*?$2)%)-$% $%)"%&% >!!P6<.&?-76-0!%+!&./!/,</!%:!&./!3/-&*+<7/)!*+,!-.%%8/!'Q*0/!
<26,/8(#!!R./!3/-&*+<7/;8!%2&76+/!5677!D/-%4/!*!D36<.&!D72/!-%7%3#!

I# %6()-% ('$0>%!E1!,/:*27&)!&./!<26,/!1%2;C/!S28&!-3/*&/,!68!'7%-0/,(!T!&.*&!68)!1%2!-*+;&!
8/7/-&!%3!4%C/!6&#!!9&!*78%!5%+;&!B36+&#!!U%5/C/3)!&./3/!*3/!*!+24D/3!%:!%B&6%+8!:%3!4%,6:16+<!
<26,/8!*+,!1%23!C6/5!%:!&./4V!

*# W3%4!&./!&%B!4/+2!D*3)!-.%%8/!View > Guides!!#%&'($")$*+,%)-#!!!!9:!
1%2;,!760/!&%!4%C/!*!<26,/!%3!,/7/&/!6&)! &!-76-0!%+!'X%-0!$26,/8(#!!
R%!.6,/!*!<26,/!@6:!1%2;,!760/!&%!</&!*! 3!6,/*!%:!.%5!&./!64*</!
5677!7%%0!5./+!B36+&/,A)!-.%%8/!'U6,/!$26,/8(#!

D# $26,/8!/G68&!%+!&./!7*1/3!6+!5.6-.!&./1!5/3/!-3/*&/,#!!>%)!6:!1%2!
-3/*&/,!1%23!<26,/!%+!1%23!R/G&!7*1/3)!5./+!1%2!.6,/!&./!R/G&!7*1/3!D1!-76-06+<! !6&8!
/1/!6+!&./!X*1/38!B*7/ /)!1%23!<26,/!5677!,68*BB/*3#!!>%4/!B/%B7/!760/!&%!-3/*&/!*!7*1/3!
S28&!:%3!<26,/8)!:%3! 3!-%+&3%7!%:!5./&./3!%3!+%&!&./1;3/!C686D7/#!

A5 %0-&'$0%"1% %

"# J./-0!&.*&!1%2!-*+!8//!&./!%B&6%+8!%+!1%23!J%7%3!B*7/ Y!6:!+%&)!-.%%8/!
'>.%5!%B&6%+8(!:3%4!&./!,3%B?,%5+!! 4/+2!@5.6-.!68!*C*67*D7/!:3%4!&./!

=# W3%4!&./!8*4/!,3%B?,%5+!4/+2)!-.%%8/!'$3*18-*7/(#!!Z%23!-%7%3!
B*7/ /!8.%27,!+%5!7%%0!760/!the!%+/!8.%5+!*&!36<.&#!

M# R%!-.*+</!*! 7!%3!8&3%0/!&%!*!8.*,/!%:!<3/1)!8/7/-&!&./!%DS/-&!1%2;3/!5%306+<!56&.)!-.%%8/!/6&./3!
&./!W677!9+,6-*&%3!%3!>&3%0/!9+,6-*&%3!%+!&./!J%7%3!B*7/ /)!*+,!-76-0!%+!&./!<3/1!&.*&!1%2;,!760/!&%!
28/!:3%4!&./!<3*,2*&/,!D*3!*-3%88!&./!D% %4!%:!&./!B*7/ /#!!K3!T!*7&/3+*&/71!T!1%2!-*+!&1B/!6+!*!
C*72/!D/&5//+![!*+,!"[[!6+!&./!&/G&!D%G!%+!&./!36<.&!86,/!%:!&./!B*7/ /#!!@[\!68!5.6&/)!"[[\!68!
D7*-0#A!

O# ]%&/V!!81% %+(B$%)"%,-&* $%&%)$<)%"CD$,)%)"% 2$ )!8/7/-&!6&!*+,!-.*+</!6&8!E8FF%,"+"2#!!R/G&!
+%34*771!.*8!!"!8&3%0/!-%7%3#!!$6C6+<!&/G&!*!8&3%0/!-%7%3!282*771!4*0/8!&./!&/G&! &!&%!3/*,^!
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Character palette 

font

style

size

!"##$%&'()*+#&(,#%--,%.%*',#/0#1,2,.%3#/45,'&16#71)*+#&(,#,8,9./--,.#&//3#

!"##$%&'($")*&'+,-./'-'01/&',&#,&%&/21/3'-',$-+4'-/+'56$%&/'-'789:;'3,-('5$0$,'<$,'12%'%2,$=&4'
-/+'>?'point'01/&'<$,'12%'.1+269''@$")+'01=&'2$'31*&'%&*&,-0'$26&,'01/&%'26&'%-A&'-##&-,-/5&9'

B00"%2,-2$,)%'C(&+,$##&,'2$$0'31*&%'-'*&,('&-%('.-('2$'+$'261%D''B2)%'51,50&+'$/'26&'2$$0E-,'%6$./'-2'
,13629''F$'"%&'124'

G9 !&0&52'26&'$EH&52'$,'$EH&52%'.6$%&'-##&-,-/5&'($")+'01=&'2$'56-/3&9''!&0&52'26&'C(&+,$##&,'
2$$09'

I9 J%1/3'26&'C(&+,$##&,'2$$04'5015='$/'26&'$EH&52'.6$%&'-##&-,-/5&'($")+'01=&'2$'5$#(9'

79 F6&'%&0&52&+'$EH&52%'.100'/$.'A-256'26&'$/&'($"'K%-A#0&+L'.126'26&'C(&+,$##&,D''F61%'
.$,=%'<$,'2&M24'2$$'N'26&'<$/24'%1O&4'5$0$,'-/+'%2(0&'.100'E&'5$#1&+'$*&,9'

#
:"##!(%*+)*+#&8-,#'(%.%'&,.)1&)'1#

@$"'6-+'-'01 0&'&M#&,1&/5&'1/'56-/31/3'2(#&'56-,-52&,1%215%'1/'P-E'G-9''Q$,'
A$,&'$#21$/%4'12)%'5$/*&/1&/2'2$'"%&'26&'R6-,-52&,'#-0& &4'%6$./'-2',13629'''B<'
($"'+$/)2'%&&'124'A-=&'12'*1%1E0&'E('%&0&521/3'Window > Type > Character'<,$A'
26&'2$#'A&/"'E-,9'

F6&'26,&&'+,$#?+$./'A&/"%'0-E&0&+'-2',1362'-00$.'($"'2$'56-/3&'E-%15'2(#&'
56-,-52&,1%215%9''S'<"2",&'0&%%$/'.100'&M#0-1/'A$,&'-E$"2'26&'$26&,'$#21$/%9'''@$"'5-/'56-/3&'2(#&'
56-,-52&,1%215%'&126&,'

T&<$,&'($"'-++'-'/&.'2(#&'&0&A&/24'$,'

T('56-/31/3'-'2(#&'&0&A&/2'($")*&'-0,&-+('5,&-2&+'N'H"%2'%&0&52'12U'26&/'%&0&52'/&.'
56-,-52&,1%215%'<,$A'26&'R6-,-52&,'#-0& 9'

'
;"#</&%&)*+#&,=&#>/.#%*8#/&(,.#/45,'&?#

Q$,'261%'&M&,51%&4'($"'A1362'.-/2'2$',$2-2&'2&M2'%$'12',"/%'1/'26&'%-A&'+1,&521$/'-%'-',$-+'!"#$%&'(%&
%)*+,"%&*'&-#.('/&*012%39''F$'+$'261%4'($"'5-/'"%&'26&'V$2-2&'2$$0&!4#-4"%5&*'&-#.('/&0%"1639''WF61%'2$$0'5-/'
E&'"%&+'2$',$2-2&'-/('$26&,'$EH&52'-0%$'N'01/&%4'#$0(3$/%4'&259X''F$'"%&'124'

G9 !&0&52'26&'#1&5&'$<'2&M29'

I9 !&0&52'26&'V$2-2&'2$$04'-/+'A$*&'($",'5",%$,'%$A&'+1%2-/5&'-.-('<,$A'26&'#1&5&'$<'2&M29''Y$.4'
+,-3'($",'5",%$,'1/'-'51,5"0-,'A$21$/9''F6&'2&M2'.100',$2-2&4'<,$A'12%'5&/2&,4'1/'26&'+1,&521$/'($"'
+,-39'

79 V&A&AE&,'6$.'26&'Shift'=&('<$,5&%'26&'Z&/'2$$0'2$'+,-.'01/&%'$/0('-2'[\4'][\4'$,'>:\'-/30&%^''B2'
6-%'26&'%-A&' '$/'26&'V$2-2&'2$$0'W-/+'A-/('$26&,'2$$0%XD''!$4'1<'($")+'01=&'($",'2&M2'2$'E&'
*&,215-04'6$0+'+$./'26&'Shift'=&('-%'($"'+,-3'.126'26&'V$2-2&'2$$04'-/+'26&'2&M2'.100L'%/-#L'2$'26&'
-/30&'($"'.-/29''

'
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!"# $%"& ' ()*+,-.* /

!"#$ %%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%

&"' ()*+$ %%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%

!"# #0+#1.*2 ,-)*$ " .$/*$/0$ 1$.0-)2)/3 *4$ '5-'6.$ 67 865- #"' "/1 *4$ 06/*$9* )/ :4)04 )* :)++ "''$"- ;
"-$ 865 )/<)*)/3 '$6'+$ *6 " '"-*8= *-")+ 0+$"/ 5'= '6+)*)0"+ -"++8= 6- >

31&.4+"-&4.2
?@ ,)++ 2$ '-)/*$1 )/ 2+"0A "/1 :4)*$ B.4"1$. 67 3-$8 "-$ 7)/$C@
D@ &5.* 2$ /6 +"-3$- *4"/ EF 9 GF@

5*16+"#7-, 8*"40+*. "&9 147*+ -&81+:"4-1& *%*:*&4.2 B!"#$%&'()* +"&,-%".#)34* )/0+51$ $+$#$/*. .504 ".
-6"1.= +"/1#"-A.= $*0@ /0+#%1&,)#0 "2"1"0,.#)34* )/0+51$ " *)*+$= +$3$/1= 2"- .0"+$ 6- /6*$ "265* 1).*"/0$.= $*0@C
H$-$= $9'+")/ )/ " 7$: .$/*$/0$. 6- '4-".$. :48 865 1$0)1$1 *6 )/051$ *4$ )*$#. 865 1)1= "/1 :48 865 046.$
/6* *6 )/0+51$ 6*4$- '6..)2+$ 7$"*5-$. 6- $+$#$/*.@ I65- -$".6/. .465+1 76++6: 7-6# 865- #"'J. '5-'6.$ "/1
*4$ '-6K$0* 06/.*-")/*.@

;&81+:"4-1& 7-*+"+,7<L (4). ). " -"/A)/3 67 *4$ 7$"*5-$. 865 +).*$1 "26<$= )0 #%3"% #+ ,(")% )1'#%,&0*" ,# ,("
'-%'#." #+ ,(" 1&'@ M* .465+1 76++6: +63)0"++8 7-6# 865- #"' '5-'6.$@ N+.6 -$#$#2$- *4$ <).5"+
4)$-"-048 .465+1 #"*04 *4$ )/76-#"*)6/ 4)$-"-048= .6 )*$#. /$"- *4$ *6' 67 *4$ +).* .465+1 "''$"- #6-$
<).5"++8 '-6#)/$/* 6/ 865- #"' *4"/ )*$#. "* *4$ $/1 67 *4$ +).*@

?@ %%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% O@ %%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%

D@ %%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% G@ %%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%

P@ %%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% Q@ %%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%

R@ %%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% S@ %%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%

E@ %%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%% ?T@ %%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%%



! "!

!"#$%& '())"&*#+
!"#$ $%&'#() #$ (*'#()+,- ./' #0 1(/ ,#2%- /$% #' '( %3*,+#) '"% 4%+$()#)5 .%"#)6 +)1 (0 1(/4 6%$#5) &"(#&%$
)(' %3*,+#)%6 %,$%7"%4%- $/&" +$

 8(/4 #)0(49+'#() "#%4+4&"1
 !"% +**%+4+)&% (0 '"% 5%(54+*"#& 0%+'/4%$ +)6 '%3'
 :+* ,+1(/' +)6 .+,+)&%
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!"#$%&'$()*$%+$",-./012-3$4536)7/31)89$:;<$=-2319>$
""

#$%&'((((((((((((((((((((((((((((((((((("
)*&'"?5/96)@AB$C/=1/7*/,$;;B$'D+%D$)7"

()*$=5,=-9/$$$
""
+,"-.&"-./&&"0$/-1"23"-.41"&5&/641&7"82*9::";"

!< =&>4&?"%$0"0/2@&6-42,"-&/%4,2:2A8"
B< C1&"$"181-&%$-46"%&-.2D"-2"6.221&"%$0"0/2@&6-42,1"32/"1&>&/$:"%$0%$E4,A"0/2@&6-1"
!" F&$/,".2?"-2"*1&"GH=+91"I/6J$0"123-?$/&"-2"6/&$-&"6*1-2%4K&D"0/2@&6-42,1<""#$%&'()&*+$%,-+',&.*%,/0'&,+-,

&.1,121')*%1,3*44,51,.0$616,+(&,+$,7(1%6089,:1/&1;51',<=",
"
$
$
$
$
$
$
$
"),1$'A$",-./012-39$,/E2/F/6"">?,/+*$&%@"
""

!< ",-./012-3$95,4)0/9+""J$-6."-.&"0/2@&6-42,"1*/3$6&"D4$A/$%"?4-."4-1",$%&"$,D"$"%$0"0/2@&6-42,"-.$-"
62*:D"/&1*:-<""><,/&@""
"
L/2@&6-42,"1*/3$6&"D4$A/$%1" J$0"0/2@&6-42,1"

$<"  

(((((("0:$,$/"M$K4%*-.$:N"(((((( 

!< "

O<"  

((((((""68:4,D/46$:""(((((( 

B< "

6<"  

(((((("62,46"(((((( 

P<" "
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 B"

"
"
"
B< ",-./012-3$=,-=/,12/9'""Q4::"4,"-.&"O:$,E"6&::1"4,"-.&"-$O:&"O&:2?<""C1&"-.&"42,91$=,-./012-3$8/015,/"32/"/&3&/&,6&<"">!,/+*$&%@"
"

"

 

 

 

 

",-./012-3$95,4)0/$$
M6.221&"3/2%'"0:$,$/7"
62,467"68:4,D/46$:7"
01&*D268:4,D/46$:N"

 

 

   

C=/02420$=,-./012-3$
3)7/$M&<A<7"J2::?&4D&7"
=2O4,12,7"IK4%*-.$:"
GR*4D41-$,-N"

    

S.$-"=,-=/,1@:2/9N"D2&1"
-.41"0/2@&6-42,"0/&1&/>&T"

U/7"41"4-"$"0-7=,-729/$
=,-./012-3"M-.$-"D2&1,9-"
0/&1&/>&"$,8"0/20&/-4&1N"

    

V4>&"$,"&5$%0:&"23"$"
7)=$=5,=-9/"32/"?.46."
-.41"0/2@&6-42,"41"?&::W

 

 

   

Added new row, to help 
students distinguish 
surfaces & projection 
names 
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1*4-&D""

M&5$%0:&1'"X&.1;0&*),;0/A7"
X+)10$,$0B*C0&*+$AN"
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""
"
"

P< GH--923I$7)=$=,-./012-39+$$95,4)0/$)36$)9=/01+"""Z.&"-$O:&"O&:2?"1.2?1"1E&-6.&1"23"Y"0/2@&6-42,"
$00/2$6.&1<""Q4::"4,"-.&"O:$,E"6&::1"4,"-.&"-$O:&"O&:2?7"4,D46$-4,A"&$6."1E&-6.91"95,4)0/$:0@8236,20B$0-320$
-,$=8)3),>"$,D"4-1")9=/01$:/J5)1-,2)8B$=-8),$-,$-*82J5/><""Q4,$::87"-.4,E"23"$"/&A42,"M2/"$"62*,-/8"2/"
62,-4,&,-N"32/"?.46."&$6."0/2@&6-42,"$00/2$6."?2*:D"O&"$"A22D"6.246&"M[2*"6$,"*1&"$,"$-:$1"2/"%$0"23"
-.&"?2/:D"32/"4D&$1N<"">D,/+*$&%@,,"

"

L/2@&6-42,"1E&-6.&1"

" "
 

L/2@&6-42,"95,4)0/     

L/2@&6-42,")9=/01    
Normal 

G5$%0:&"23"$"
/&A42,">-+',120;/419,
EF-'*)0A9,G'0$)1A9,
EF'*H+$0A@"-.$-"82*"
%4A.-"%$0"?4-."
-.41"1*/3$6&"\"
$10&6- 

   "

"
"

$
$
$
$
$
"),1$;A$$GH--9/$9-7/$=,-./012-39"">I,/+*$&%@,
$
Q2/"-.41"0$/-"23"-.&"$114A,%&,-7"82*/"@2O"41"-2"6.221&"$"0/2@&6-42,"32/"-./&&"%$01<""H4%4:$/"-2"?.$-"?&"D4D"4,"
6:$117"82*9::"?2/E"-./2*A."$"1&/4&1"23"R*&1-42,1"-2":2A46$::8"$//4>&"$-"12%&"$00/20/4$-&"0/2@&6-42,1<""]$146$::87"
-.&"R*&1-42,1"$/&'"
"

!< S.$-"E4,D"23"$66*/$68"41"%21-"4%02/-$,-"32/"-.41"%$0"M-.$-"417"?.$-"=,-=/,12/9"$/&"6/4-46$:TN"

B< S.$-"=-,12-3$-4$1H/$F-,86"41"O&4,A"%$00&DT"

P< ]$1&D"2,"!"$,D"B7"?.$-"0/2@&6-42,1"$/&"1*4-$O:&T"

Y< S.$-"0/2@&6-42,")9=/01"1.2*:D"O&"*1&DT""+3"$,"2O:4R*&"$10&6-"41"6.21&,7"?.&/&"1.2*:D"-.&"0/2@&6-42,"O&"
6&,-&/&DT"

$
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K)=$LA$K2I,)12-3$4,-7$1H/$"H282==23/9$23$1H/$;D1H$G/315,@$
"

!< Z.41"%$0"*1&"$//2?1"23">$/42*1"?4D-.1"-2"1.2?"-.&",*%O&/"23"4%%4A/$,-1"3/2%"-.&"L.4:4004,&17"
O&-?&&,"!_``"$,D"B```7"-2"62*,-/4&1"$::"2>&/"-.&"?2/:D<"?H29$29$)$1H/7)120$7)="a"4-1"0*/021&"41"-2"
1.2?"-.&"0$--&/,"23"&%4A/$-42,<""C=/02420$6291)30/9$4,-7$1H/$"H282==23/9$),/$9/0-36),@<"MH)1$
=,-=/,1@$-,$=,-=/,12/9$),/$7-91$0,2120)8$4-,$1H29$7)=N""Z2".&:0"D&-&/%4,&"82*/"$,1?&/7"/&6$::"2*/"
6:$11"D416*1142,<""b4/6:&"82*/"6.246&M1N"O&:2?<"

"
GR*$:W$/&$"M&R*4>$:&,6&N" b2,32/%$:4-8" GR*4D41-$,6&" IK4%*-.$:4-8"
"
]/4&3:8"&50:$4,"82*/"6.246&'"

"
"
"
"
"

B< Z.41"41"$,"&$18"2,&"a"S.$-"02/-42,"23"-.&"?2/:D"41"O&4,A"%$00&DT"
"

""""""""Z.&"?2/:D" I".&%410.&/&" I"62,-4,&,-"2/"26&$," I"/&A42,"2/"62*,-/8"

"
P< #2?7"6.221&"-?2"/&$12,$O:&"0/2@&6-42,1"32/"-.41"%$0<""GH--9/$9=/02420$=,-./012-39B$3-1$)$95,4)0/$

-,$=,-=/,1@A$"C1&"-.&"1&:&6-42,"A*4D&"D41-/4O*-&D"4,"6:$117"2/"4-1"2,:4,&">&/142,"$-"
.--0'cc???<0*O:46<$1*<&D*cd$2O:-cPe!c0/2@&6-42,1WE&8<.-%<""

" "
" !<"((((((((((((((((((((((((((((((((((("""B<"(((((((((((((((((((((((((((((((((((((("
"
"
Y< S.&/&"D2"82*"-.4,E"-.&"%$091"6&,-&/"1.2*:D"O&T""S.8T"">J(%&,61%)'*51,0,4+)0&*+$,K,*$,L0'&,!,8+(M44,-*$6,*&%,

40&*&(61,0$6,4+$C*&(61"@,
"
"
"
"
"
"
K)=$OA$$"-=58)12-3$6/3921@$7)=$-4$L591,)82)$
"

!< C14,A"D$-$"3/2%"I*1-/$:4$91"%21-"/&6&,-"6&,1*17"-.41"%$0"?4::"1.2?"-.&">$/4$-42,"4,"I*1-/$:4$91"
020*:$-42,"D&,14-8<""S.$-"14,A:&"0/2@&6-42,"0/20&/-8"41"%21-"6/4-46$:"32/"-.41"%$0T"

"
GR*$:W$/&$"M&R*4>$:&,6&N" b2,32/%$:4-8" GR*4D41-$,6&" IK4%*-.$:4-8"
"
]/4&3:8"&50:$4,"?.8"82*"6.21&"-.41"0/20&/-8'"
"
"
"
"
"
"
"
"
"
"
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B< IA$4,7"4D&,-438"?.$-"02/-42,"23"-.&"?2/:D"41"O&4,A"%$00&D'"
"

""""""""Z.&"?2/:D" I".&%410.&/&" I"62,-4,&,-"2/"26&$," I"/&A42,"2/"62*,-/8"
"
P< b.221&"1F-"$00/20/4$-&"0/2@&6-42,1"32/"-.41"%$0<"
" "

!<"((((((((((((((((((((((((((((((((((("""B<"((((((((((((((((((((((((((((((((((((""
"

]/4&3:8"&50:$4,"?.8"82*"6.21&"-.&1&"0/2@&6-42,1'"
"

"
"
"
"
"
"

D" S.&/&"1.2*:D"-.&"%$0"0/2@&6-42,"O&"6&,-&/&DT""S.8T"">FC0*$9,N(%&,0,B1'504,61%)'*/&*+$,*%,-*$1@,
"
"
"
"
"
$
K)=$GA$$L$3)E2I)12-3)8$7)=B$1-$*/$59/6$23$=8-1123I$)2,$482IH19$4,-7$K2)72$1-$7).-,$0212/9$-4$P5,-=/$
"

!< I1"4,"$::"$4/",$>4A$-42,7"-.&"A2$:"41"-2"34,D"-.&"9H-,1/91$,-51/"3/2%"J4$%4"-2"-.&"G*/20&$,"
D&1-4,$-42,1"a"-.$-"417"-.&"A/&$-"64/6:&"/2*-&1<""H2"-.41"%$0"1.2*:D"*1&"$"0/2@&6-42,"2,"?.46."4-91"&$18"
-2"0:2-"A/&$-"64/6:&"/2*-&1<""Z.&"%$0"1.2*:D"$:12"1.2?"-.&"=,/029/$6291)30/"O&-?&&,"-.&"-?2"64-4&1<""
S.$-"B"0/20&/-4&1"$/&"%21-"4%02/-$,-"32/"-.41"%$0T"

"
GR*$:W$/&$"M&R*4>$:&,6&N" b2,32/%$:4-8" GR*4D41-$,6&" IK4%*-.$:4-8"
"

B< S.$-"02/-42,"23"-.&"?2/:D"41"O&4,A"%$00&DT"
"

""""""""Z.&"?2/:D" I".&%410.&/&" I"62,-4,&,-"2/"26&$," I"/&A42,"2/"62*,-/8"
"
P< C14,A"-.&"1$%&"/&3&/&,6&1"$1"32/"-.&"0/&>42*1"%$07"6.221&"-3/"$00/20/4$-&"0/2@&6-42,"32/"-.41"%$0<"""
" "

L/2@&6-42,"6.21&,'"""(((((((((((((((((((((((((((((((((((((((((((""
"

]/4&3:8"&50:$4,"?.8"82*"6.21&"-.41"0/2@&6-42,'"
"
"

"
"

"
"

"
Y< S.&/&"1.2*:D"-.41"0/2@&6-42,"O&"6&,-&/&DT"
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"#$%&'''''''''''''''''''''''''''''''''''(
)*%&(!"#$%&'()*#+,#-.#/)00()12342)&-(

)
)
567)481)9&.)4):)6&/,)4;))<$#)=/>?&+),@)-&A#)-&+$)BC)'@"/)>D@$#C)+/@E#>,B@C$))!"#$%&'()*)
)
+,(-./0(0%1-/2,3(42*566(7%,%8#-%(9#0%$#:0(;28(-.%(-.8%%($#:(-2:/10(42*(<28=%>(2,(/,(-.%(:8%?/2*0(0%1-/2,@((
A#1.(9#0%$#:(</66(0.2<(#(78#-/1*6%(#,>(12*,-84(2*-6/,%03(#,>(</66(9%(/,(#(:82B%1-/2,(-.#-(42*(0%6%1-%>(/,(C#8-(D@(((
(
+;(42*(<%8%($#=/,7(;/,/0.%>($#:03(42*(12*6>(*0%(%/-.%8(E81F#:(28(+66*0-8#-28(-2(:62-(-.%(;62<(#882<03(
:2:*6#-/2,(>%,0/-/%03(#,>(#(78%#-(1/816%(82*-%@((G*-(-.#-(1#,(<#/-(;28(;*-*8%(%H%81/0%0I(((
(
J%8%(#8%(/,0-8*1-/2,0(2,(7%--/,7(0-#8-%>(/,(E81F#:3(#,>(-.%,(:62--/,7(-.%(9#0%$#:0&(
(
(

5#,,BCF)$,&/,#%)GB,D)=/>?&+)
(
(
H;))5#,),D#)IBJ#$)'@"KJJ)C##%3)K.%(D(;/6%0(#8%(2,(-.%(16#00(<%9(0/-%3(/,(-.%(Lab 3(;26>%8(*,>%8(Lab Info@((L2662<(

/,0-8*1-/2,0(2,(-.%(<%9(0/-%3(<./1.(%H:6#/,(<.%8%(-2(0#?%(-.%(;/6%0@(
)
)
)
HH;))HI)'@"KJJ).#)G@/ABCF),D/@"FD)?')=++$3)))

(
M@ N2#>(F4(E::03(%/-.%8(;82$(F4EOP(28(

.--:&QQ$4#::0@#0*@%>*@(
(

D@ +,(-.%(O%#81.(92H3(0%#81.(;28(ArcMap@(
(

R@ K.8%%(2:-/2,0(</66(#::%#8@((L28(-./0(#00/7,$%,-3(*0%(-.%($20-(
8%1%,-(?%80/2,3(E81F#:(S@R(!+&,+-./#0(#,&12(*@(

(

T@ U.220%( 3(-.%,( .(
(
(
(
HHH;))=JJ)$,"%#C,$)L)GD#,D#/)G@/ABCF),D/@"FD)?'=++$)@/)@C)&)>@-+",#/)GB,D)=/>?&+)BC$,&JJ#%3)
(

V@ M+#C),D#)9&.)4)+/@E#>,)IBJ#3))E;-%8(E81F#:(62#>03(42*566(0%%(#(>/#627(-.#-(7/?%0(42*(02$%(

2:-/2,0(;28(.2<(-2(0-#8-@((U.220%(( 3(-.%,(16/1=(WXYZ@((((

(
!@ "#?/7#-%(-2(42*8(W:82B%1-/2,0Z(;26>%83(#,>(1.220%( .(

(
[@ \2*(0.2*6>(0%%(#(6/0-(2,(-.%(6%;-3(#,>(#(<286>($#:(2,(-.%(8/7.-@((!34#5%6#/%'7(8#+2.+9#:&(2#;.<*(

(
]@ C821%%>(-2(,%H-(:#7%(2;(/,0-8*1-/2,0@(

(
)
)
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HN;))5#,),@)AC@G),D#)=/>?&+)BC,#/I&>#)
(
^.%,(W6#9R@$H>Z(2:%,03(42*8(018%%,(</66(622=(02$%-./,7(6/=%(-.%(/$#7%(.%8%&(

(
(
(
M@ +;(-.%(E81F#:(</,>2<(>2%0,5-(;/66(-.%(12$:*-%8(018%%,3($#=%(/-(6#87%8(94(16/1=/,7(-.%($#H/$/_%(9*--2,(

/,(-.%(*::%8(8/7.-(128,%8(2;(-.%(</,>2<@(((
(
D@ +;(-.%($#:(>2%0,5-(;/66(-.%(0:#1%(#?#/6#96%(2,(-.%($#:(>/0:6#43(1.220%(WView > Zoom Data > Zoom Full 

ExtentZ(;82$(-.%($%,*(9#8@(((
(
R@ K.%($#:(-.#-(42*(0%%(/0(/,(<.#-(E81F#:(1#660(#(W7%278#:./1Z(:82B%1-/2,@((+,(-./0(:82B%1-/2,3(92-.(

$%8/>/#,0(#,>(:#8#66%60(.#?%(%`*#6(0:#1/,7(#66(2?%8(-.%($#:@((L28(<.#-(#8%#0(2;(-.%(<286>(>2%0(-./0(
0:#1/,7(:82>*1%(-.%($20-(>/0-28-/2,a(

''''''''''''''''''''''''''''''''''''''''''''''''''''''!=>?#$(*#

#

"2<(42*58%(8%#>4(-2(:62-(42*8(R(9#0%$#:03(#0(>%018/9%>(2,(-.%(;2662</,7(:#7%0@((+;(42*58%(#(,%<12$%8(-2(b+O3(.%8%50(
#(6/--6%($28%(/,;28$#-/2,&(

=)O#/')$D@/,)BC,/@%">,B@C),@)5H*)IBJ#$)&C%)%&,&3)

b+O(02;-<#8%(8%`*/8%0(D(9#0/1(-4:%0(2;(;/6%0&(((

 P&,&)IBJ#$(cc(0-28%(-.%(0.#:%0(2;(7%278#:./1(;%#-*8%03(#,>(1#,(#602(0-28%(#66(=/,>0(2;(>%018/:-/?%(
/,;28$#-/2,(#92*-(-.%(621#-/2,0@((d+;(42*(>2<,62#>%>(>#-#(;82$(G6#1=92#8>3(42*(0#<(-<2(;/6%0(1#66%>(
W^286>@6>95(#,>(^286>@$>9@((K.%0%(-<2(;/6%0(0-28%(-.%(12*,-84(#,>(21%#,(6#4%80(-.#-(42*566(<28=(
</-.(/,(-./0(#00/7,$%,-@e(

 6/@E#>,)IBJ#$(f(0-28%(-.%(#::%#8#,1%(2;(-.%(>#-#(;/6%0(#0(42*(0%%(-.%$(/,(E81F#:@(( (/0(#(
:82B%1-(;/6%@((+-(0-28%0(/,;28$#-/2,(#92*-(-.%(12628(2;(-.%(6#,>(#,>(21%#,3(#,>(-.%(0/_%(2;(-.%(/$#7%(/,(
-.%($#:(>/0:6#4@((X,1%(42*(0-#8-(1*0-2$/_/,7(42*8($#:(>/0:6#4(94(7/?/,7(/-(#(:82B%1-/2,3(/;(42*5>(6/=%(
-2(0#?%(42*8(<28=3(42*(1#,(0#?%(42*8(2<,(?%80/2,(2;(6#9R@$H>@((J2<%?%8(f(+;(42*(0%,>($%(-.%0%(
;/6%03(+(1#,5-(0%%(42*8($#:03(9%1#*0%(+(>2,5-(.#?%(-.%(>#-#(;/6%0@((!D&,K$)GD'(),@)$D&/#)'@"/)G@/A)BC)
5H*()'@"KJJ)"$"&JJ')>/#&,#)IBJ#$)BC)$@-#)@,D#/)I@/-&,()JBA#)Q6R5)@/)6PS;(

Map 
display 

Table of 
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Menu bar
Toolbars
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 ]

1a - i 

1a -  ii 

T/#&,BCF),D#)4).&$#-&+$)
(

(
=;))T/#&,#),D#)6DBJB++BC#$)-BF/&,B@C).&$#-&+)
(

M@ SBC%),D#)-&+K$)>#C,#/3((+;(42*(:6#,(-2(1%,-%8(42*8($#:(
02$%<.%8%(2-.%8(-.#,(#-(-.%(C8/$%(F%8/>/#,(d6/=%(2,(-.%(
C./6/::/,%0ae3(42*566(,%%>(-2(=,2<(-.%(62,7/-*>%(2;(42*8(
>%0/8%>($#:(1%,-%8@((P0/,7(E81F#:3(42*(1#,(;/,>(
#::82H/$#-%(6#-/-*>%(#,>(62,7/-*>%(2;(#(621#-/2,(#0(;2662<0&(

#@ F2?%(42*8(1*8028(#82*,>(2?%8(-.%($#:@((E0(42*($2?%(/-3(,2-/1%(-<2(0%-0(2;(,*$9%80(/,(-.%(
62<%8c8/7.-(128,%8(2;(-.%(E81F#:(</,>2<(-.#-(=%%:(1.#,7/,7(!-&9.#@08#0A%B.#,&12(*>##K.%0%(
,*$9%80(7/?%(-.%(1*802850(:20/-/2,(2,(-.%(%#8-.50(0*8;#1%3(%/-.%8(/,($%-%80(28(>%78%%0(6#-/-*>%(#,>(
62,7/-*>%@(()HI)'@"/)BC,#/I&>#)B$)$D@GBCF)-#,#/$)/&,D#/),D&C)F#@F/&+DB>)>@@/%BC&,#$&(

(

/@ g/7.-c16/1=(2,(  on the left-hand side@((E($%,*(
</66(#::%#8(f(;82$(-.%(?%84(92--2$(2;(-./0($%,*3(0%6%1-(
W6/@+#/,B#$Z#!C..#@0#D&8#0(#,&12(*>#(((E(6#87%(>/#627(92H(1#66%>(
WP&,&)S/&-#)6/@+#/,B#$Z(</66(#::%#8@((+;(-.%(W5#C#/&JU(
-#9(/0,5-(/,(;82,-3(16/1=(/-(-2(98/,7(/-(-2(-.%(;82,-@(

//@ U.#,7%(-.%(0%--/,7(;28(WDisplayZ(*,/-0(-2(WDegrees Minutes 
SecondsZ(28(WDecimal DegreesZ(!C..#@0#D#&&8#0(#,&12(*@((U6/1=(2,(
WOKZ@(

(
9@ "2-/1%(-.#-(-.%(1228>/,#-%(>/0:6#4(,2<(7/?%0(-.%(1*802850(621#-/2,(

/,(6#-/-*>%(#,>(62,7/-*>%(1228>/,#-%0@((!D#)IB/$,)>@@/%BC&,#)FBO#$)
J@CFB,"%#)V-#/B%B&CWX),D#)$#>@C%)>@@/%BC&,#)FBO#$)J&,B,"%#)
V+&/&JJ#JW;((O%-(42*8(1*8028(2?%8(-.%(C./6/::/,%03(#,>($#=%(#(,2-%(
.%8%(2;(#,(#::82:8/#-%(1%,-8#6($%8/>/#,(;28(-./0($#:((d\2*($/7.-(
82*,>(2;;(42*8(8%#>/,7(-2(-.%(,%#8%0-(V°)&(

(
U%,-8#6($%8/>/#,&((('''''''''''''''''''''''''''(!=>?#$(>*#

(

D@ 6J@,),D#)-&+)+/@E#>,B@C$)'@")>D@$#)I@/),DB$)-&+)BC)6&/,)0@((K*8,(-2(-.%(7%,%8#6(>/8%1-/2,0(2,(
+&F#$)11:10)@I),DB$)D&C%@",@((K.%4(%H:6#/,(.2<(-2(:62-(-.%(-<2(:82B%1-/2,0(42*(0%6%1-%>(;28(-./0(
$#:3(#,>(.2<(-2(1%,-%8(%#1.(:82B%1-/2,@(

R@ =I,#/)G@/ABCF),D/@"FD),D#)%B/#>,B@C$)@C)+&F#$)11:103(((

#@ U.220%(42*8(;#?28/-%(:82B%1-/2,3(#,>($#=%(0*8%(/-50(1%,-%8%>(#0(42*(/,-%,>%>@(

9@ K*8,(/,(#,(/$#7%(2;(-.%(:82B%1-/2,(cc(%/-.%8(/,(:8/,-%>(;28$(28(#0(#(hCAb(;/6%(f(<./1.%?%8(42*(
:8%;%8@(((

 !@)+/BC,),D#)-&+&(U.220%(File > Print@((9&.#J),D#)+/BC,#%)-&+)GB,D),D#)C&-#)@I),D#)
+/@E#>,B@C)'@")$#J#>,#%;)

 !@)$&O#),D#)-&+)&$)&)Q6R5)IBJ#&((U.220% File > Export Map.  L28(-.%(2:-/2,(WSave as 
typeZ3(1.220%(hCAb@((K.%,3(C&-#),D#)IBJ#)Y4&U(d;28(-.%(6#9(i(#,>($#:(ie(I@JJ@G#%).')
,D#)C&-#)@I),D#)+/@E#>,B@C)'@")$#J#>,#%@((^.%,(42*5?%(12$:6%-%>(#66(R($#:03(42*(1#,(
0%,>(-.%$(-2($%(?/#(%$#/6(d9-6j#0*@%>*e3(28(*:62#>(-.%$(-2(-.%()/7/-#6()82:92H@ 
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Conic projections 
 

Planar projections 
 
 
Cylindrical and pseudocylindrical projections 
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Cylindrical and Pseudocylindrical projections: 
Enter the desired central longitude of your map* in the 
Central Meridian field. 

(

Conic projections: 
Enter the desired central longitude of your map* in the 
Central Meridian field. 

In the Standard Parallel_1 field, enter a latitude** 
about halfway between the top and middle of the 
region you’re mapping. 

In the Standard Parallel_2 field, enter a latitude about 
halfway between the middle and bottom of the region 
you’re mapping. 

 

Planar projections: 
Enter the desired central longitude* of your map in the 
Central Meridian field. 

In the Latitude of Origin field, enter the desired 
central latitude of your map.** 

Important: 

* Longitudes in the Western hemisphere are stated as negative numbers (so to indicate a Central 
Meridian of 112 W, type “-112”). 

** Latitudes in the Southern Hemisphere are also stated as negative numbers (so to indicate a Standard 
Parallel of 20 S, type “-20”). 

(
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